Release Notes for Modo 11.2v1

Release Date

7 November 2017

Copyright © 2017 The Foundry Visionmongers Ltd.

System Requirements

Officially Supported Operating Systems

• Mac OS 10.10.x, 10.11.x, and 10.12.x (64-bit only)
• Windows 7, Windows 8, and Windows 10 (64-bit only)
• Linux 64-bit operating system (CentOS/RHEL 7+)

Minimum Hardware Requirements

• Intel processor(s), Core i3 or higher
• 1 GB available hard disk space (for Modo installation).
• 6 GB available hard disk space (for full content).
• At least 4 GB RAM
• Display with 1920 x 1080 pixel resolution
• Internet connection for product activation and online videos access
• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended System Requirements

⚠️ NOTE: This information is our best recommendation for the average user. Requirements vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor
• 250+ GB disk space available for caching and temporary files, SSD is preferable
• 16 GB RAM with additional virtual memory*
• Display with 1920 x 1080 pixel resolution
• An NVIDIA or AMD graphics card with the latest drivers
• 2+ GB of graphics memory
• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

Tested Workstation Hardware

The configurations listed below are those that The Foundry have tested with Modo. Due to the constantly changing nature and wide variety of computer hardware available in the market, The Foundry is unable to officially certify hardware. The list below can be used as a recommendation and does not guarantee that it meets your particular needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure that you are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

<table>
<thead>
<tr>
<th>Tested Workstation Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple</td>
</tr>
<tr>
<td>• MacBook Pro 2017</td>
</tr>
<tr>
<td>• MacBook Pro (Mid 2015)</td>
</tr>
<tr>
<td>• MacBook Pro 2014</td>
</tr>
<tr>
<td>• Mac Pro (Late 2013)</td>
</tr>
<tr>
<td>• MacBook Pro10, 1</td>
</tr>
<tr>
<td>• MacPro4, 1</td>
</tr>
<tr>
<td>• MacPro5, 1</td>
</tr>
<tr>
<td>• iMac13, 2</td>
</tr>
</tbody>
</table>

| Dell                        |
| • Dell T1700                |
| • Dell T3610                |
| • Dell T3620                |
| • Dell T5810                |
| • Dell T7610                |
| • Dell T7910                |
| • Dell Precision 3520      |
## Tested Workstation Hardware

<table>
<thead>
<tr>
<th>Dell Precision Rack 7910</th>
<th>Dell Precision 5510</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Precision 5520</td>
<td>Dell Precision 7710</td>
</tr>
<tr>
<td>Dell Precision 7720</td>
<td>Dell M2800</td>
</tr>
<tr>
<td>Dell M6800</td>
<td>Dell XPS 15 9560</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HP</th>
<th>HP Z800</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Z640</td>
<td>HP Z620</td>
</tr>
<tr>
<td>HP Z600</td>
<td>HP Z440</td>
</tr>
</tbody>
</table>

## Tested GPU Hardware

### AMD Prosumer Graphics Cards

<table>
<thead>
<tr>
<th>Radeon™ HD 1900 XT</th>
<th>Radeon™ HD 2400 XT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radeon™ HD 2600 Pro</td>
<td>Radeon™ HD 3870</td>
</tr>
</tbody>
</table>

### AMD Enterprise Graphics Cards

<table>
<thead>
<tr>
<th>FirePro™ D700</th>
<th>FirePro™ W4170</th>
</tr>
</thead>
<tbody>
<tr>
<td>FirePro™ W5000</td>
<td>FirePro™ W8000</td>
</tr>
<tr>
<td>FirePro™ W2100</td>
<td>FirePro™ W5100</td>
</tr>
<tr>
<td>FirePro™ W4100</td>
<td>FirePro™ W7100</td>
</tr>
<tr>
<td>FirePro™ W8100</td>
<td>FirePro™ W9100</td>
</tr>
<tr>
<td>Tested GPU Hardware</td>
<td></td>
</tr>
<tr>
<td>---------------------</td>
<td></td>
</tr>
<tr>
<td>• Radeon Pro 560</td>
<td></td>
</tr>
<tr>
<td>• Radeon Pro WX7100</td>
<td></td>
</tr>
<tr>
<td>• Radeon Pro WX5100</td>
<td></td>
</tr>
<tr>
<td>• Radeon Pro WX4100</td>
<td></td>
</tr>
<tr>
<td>• Radeon R9 M370X</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NVIDIA Prosumer Graphics Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>• GeForce GT 750M</td>
</tr>
<tr>
<td>• GeForce GTX 680</td>
</tr>
<tr>
<td>• GeForce GTX Titan</td>
</tr>
<tr>
<td>• GeForce GT 650M</td>
</tr>
<tr>
<td>• GeForce GTX 1080 Ti</td>
</tr>
<tr>
<td>• GeForce GTX 1080</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NVIDIA Enterprise Graphics Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Quadro® K6000</td>
</tr>
<tr>
<td>• Quadro® K5200</td>
</tr>
<tr>
<td>• Quadro® K5000</td>
</tr>
<tr>
<td>• Quadro® K4200</td>
</tr>
<tr>
<td>• Quadro® K4000</td>
</tr>
<tr>
<td>• Quadro® K2200</td>
</tr>
<tr>
<td>• Quadro® K2000</td>
</tr>
<tr>
<td>• Quadro® K1200</td>
</tr>
<tr>
<td>• Quadro® K600</td>
</tr>
<tr>
<td>• Quadro® K620</td>
</tr>
<tr>
<td>• Quadro® M5000</td>
</tr>
<tr>
<td>• Quadro® M4000</td>
</tr>
<tr>
<td>• Quadro® P4000</td>
</tr>
<tr>
<td>• Quadro® M620</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NVIDIA Quadro Graphics Cards:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• P400</td>
</tr>
<tr>
<td>• P600</td>
</tr>
<tr>
<td>• P1000</td>
</tr>
<tr>
<td>• P4000</td>
</tr>
<tr>
<td>• P5000</td>
</tr>
</tbody>
</table>
New Features

Alembic I/O Improvements

Replicator Alembic Export Enhancements

Modo's replicator exporting workflow has been improved for better between Modo and other DCC applications, such as Katana and Houdini.

The Alembic I/O Preferences now includes an Export Replicas As option which allows you to specify the type of data to export. You can select whether to export Alembic replicas as Geometry, Particles, or both Particles and Geometry.

Camera Improvements

Background and Foreground Images

The Camera View properties have been updated to include an Enable option for both the Foreground and Background images. When toggled off, the image is not displayed in your rendering, but remains in your scene.

Framing Regions Improvements

A new option, Show Camera Framing Region, has been added to toggle the visibility of the camera framing regions the 3D Viewport.

Cloud Asset Browser

Using the Cloud Asset Browser

Modo Share Site Presets and some Modo Kits are now stored in the cloud on a shared-site for easy access. These presets are organized and categorized for quick visual browsing. You can select which presets you would like to work with and download them onto your local drive. Simply double-click on the desired preset or kit in the Cloud Asset folder and it is installed onto your local system.
Direct Modeling Improvements

Polygon Bevel Improvements

The **Polygon Bevel** tool has a number of new options to improve your workflow. The following options have been added:

- **Square Corner** - Adds quadrangles at each sharp corner of the boundary polygons. When **Group Polygons** is enabled, quadrangles are created at the corner vertices connected to the selected polygon(s).
- **Offset Even** - Makes the distance of the inserted face even. This option is enabled by default. When this option is disabled, the edge length between source vertex to the new source vertex is same as set **Inset** value.
- **Edge Rail** - This option works with the **Group Polygons** option. When this option is enabled, the new vertex from the source vertex is created along an inner edge, which is connected to the contour source vertex. If there are multiple inner edges, the most perpendicular to the contour edge is selected.
- **Thicken** - Adds flipped copies of the source polygons to add thickness to the operation.

Edge Bevel Improvements

The **Edge Bevel** tool has been updated to improve your workflow when working with faceted polygons. The following options have been added:

- **Mitering Offset** - With **Edge Shape** set to **Round** and **Mitering Offset** enabled, this option creates extra co-planar polygons beside the outer edges of your mesh to smooth artifacts on connecting polygons.
- **Maintain Co-Planar Edges** - Fixes co-planar edge errors when you are detailing faceted polygons from roughed out shapes. When this option is enabled, the unselected co-planar edges merge with the next unselected sharp edge, creating an even surface.

Snapping Improvements

To improve your workflow when snapping geometry in heavy meshes, we have updated the Geometry Snapping tool to include a new option called **Only Selected**. When enabled, geometry snapping finds the element to be snapped to from the selected polygons of the Foreground.
File I/O Updates

FBX 2017 / FBX 2018 Plug-in

Autodesk FBX 2017 and Autodesk FBX 2018 import and export support has been added.

Item Handling Improvements

Channel Hauling Improvements

The Channel Haul tool has been updated to automatically display user channels in the 3D Viewport.

MeshFusion Improvements

Edge Weighting Support

A new Edge Weighting option has been added to the Fusion Item properties, which simulates Catmull-Clark edge-weighting by internally adding edge loops to the source meshes.

Performance Improvements

A new Draft Unions option has been added to the Fusion Item properties to improve performance while working on a model. You can now automatically and adaptively split the Fusion Item into active and inactive parts.

Item Based Material Groups

A new Mesh Mode option has been added to the Fusion Item properties to improve performance. You can specify the mesh type for the 3D viewport display and output. The following options have been added:

- Draft - Best Performance - Recommended for full performance optimization. This option is not recommended for Output (Strips and Surfaces are not unified).
- Airtight Draft - Sets to the minimum airtight properties. Strips and surfaces are unified but no further refinement or optimization of the mesh is performed. This option may be slightly faster than other airtight mesh modes.
• **Airtight Final** - Uses properties to produce the best topology output. Strips and surfaces are unified. Closely spaced vertices are merged. Pairs of tri-polygons are converted to quads where possible. No Selection Sets, Parts, or Material groups are created.

• **Airtight Final w/Parts** - Uses the same mesh topology properties as **Airtight Final** and creates polygon Selection Sets, Parts, and Material groups.

• **Airtight Final Item Parts** - Creates the same mesh topology as the **Airtight Final** mode. Like **Airtight Final w/Parts**, this option creates polygon Selection Sets, Parts, and Material Groups.

**RibTrim and ElboPipe Assemblies**

Modo now provides two new procedural **MeshFusion Assemblies**, which allows you to work with simple geometries and familiar direct modeling workflows and tools. The following assemblies have been added to this release:

• **ElboPipe** - Creates piping consisting of straight segments and relatively short bends (with optional elbow joint geometry at the bends). Use the Pen Extrude Mesh Operation to create your ElboPipe curves. You can create a path as a polyline to create elbows around the geometry. As a result, the geometry is automatically added at each vertex of the polyline.

• **RibTrim** - Automates the creation of frame, rib, and tile structures. This assembly creates patterns of edge looped blocks that may be used as Fusion Trims or Mesh Roles and Relationships. The blocks are aligned to selected geometry using a procedural UV Transform and/or a procedural Deformer- You can create and edit patterns as simple 2D meshes by creating planes with an arbitrary arrangement of polygons.

**Fusion Pie Menu and Drag and Drop**

Both the MeshFusion pie menus and drag-and-drop modifier keys have been updated to improve your workflow when working with MeshFusion Items. Some older, outdated, pie menus options have been removed along with others that were not often used. In addition, we have added ability to use modifier key shortcuts with drag-and-drop workflows.

**Performance Improvements**

**Weight Editing**

The workflow for editing weight values while manipulating deformed rigging characters has been improved. The performance speed for the Weighting Tools, **Adjust Weights** option, now only updates cached elements when you are changing a sub-set of points, such as an arm or finger on a larger character. Performance gains are significant when working with smaller selection sets.
Preferences Improvements

Paint Foreground Color Preference

A new preference, **Default Foreground Color** has been added, which allows you to change the default paint color of the foreground while working in the **Paint** layout. The default value is **White**.

Procedural Modeling Improvements

Select by Previous Operation

The **Slice**, **Axis Slice**, **Axis Drill**, **Solid Drill**, **Boolean**, and **Curve Slice** Mesh Operations now support **Select by Previous Operation**.

Text Tool

The performance of the **Text** tool has been improved. The **Make UVs** option is now disabled by default.

Set Polygon Type

A new **Set Polygon Type** tool has been added as a procedural Mesh Operation, which allows you to convert polygon types at any point during your design workflow. You can convert polygons into **Faces**, **Subdivision** surfaces or **Catmull-Clark** polygons.

Flip Polygons

To improve your workflow, we have added the **Flip Polygons** tool, which enables you to quickly reverse the normals of polygons.

Select by Polygon Tag

A new procedural Mesh Operation, **Select by Polygon Tag**, has been added, which allows you to select polygons based on a polygon tag, such as **Material**, **Part**, or **Selection Set**.
Rendering Improvements

True Fresnel Improvements

The 3D Viewport specular and reflection display response has been improved when using an Index of Refraction.

Principled BRDF Shader Model

Modo now contains a new shader model called Principled, which is based on the paper from Brent Burley of Walt Disney Animation Studios.

Scene Improvements

Scene Cleanup

Modo now allows you to remove empty mesh items, empty groups, and unused items from your current scene.

LRL images

Modo now allows you to create and share assets containing embedded URLs from your Preset Browser.

UI Improvements

Morph in Vertex Normal Tools

The 3D Viewport properties have been updated to include new Morphed Mesh Drawing options. The following options have been added:

- **Vector** - Draws line segments from the vertices of the base mesh to the corresponding vertices of the morph mesh.
- **Vector Color** - Specifies the color of the vector lines.
- **Vector Opacity** - Specifies the opacity value of the vector lines.
In addition, the Vertex Map Tools has a new option, Enable Morphs (Current Viewport), which displays the results of animated morphs in the 3D Viewport.

Unreal Bridge Plug-in Improvements

A number of changes to our Modo Bridge plug-in have been made to improve the workflow for Game Engine users. A more consistent workflow between Unreal and Modo has been implemented allowing you to work in multiple scenes seamlessly. The Push interface is simplified and the progress bar is improved for our Modo Bridge plug-in and the Unreal Client. In addition, we have added the following Application preferences:

- **Search Subfolder** - Toggles whether to search into subfolders to find the assets to push to the Unreal Editor.
- **Actor Identification** - Defines how to find the same actors in the Unreal client.
- **Asset Naming** - Defines how assets are named in the Unreal Editor.

Reset Mesh Asset

A new push option, Reset Mesh Asset, has been added to the Modo Bridge plug-in. Modo now distinguishes the difference between a mesh actor from a mesh asset. An Unreal mesh actor is always a Modo instance item and an Unreal mesh asset is always a Modo mesh item.

UV Improvements

Show Flipped UV in the UV Viewport

A new UV Viewport option, Show Flipped, has been added to display the orientation of your UV islands.

Select Unmapped Polygons Tool

A new Select Unmapped Polygons tool has been added to help you locate polygons that do not have UVs in a given UV map.

Show UV Distortion in the 3D Viewport

A new Show UV Distortion option has been added to toggle the display of overlay colors that show the distortion of the UVs on the 3D model.
Select Error UVs

The Select Overlapped Polygons tool has been renamed Select Error UVs and the following options have been added:

- **Stacked** - Selects identical UV polygons that are located at the same location in UV space.
- **Crossing UDIM Borders** - Detects UVs crossing UDIM borders.
- **Zero Area** - Selects shrunken polygons in the UV space. These are shrunken to the line or point with a zero area size.

Create UV Tool Improvements

The Create UV Map Mesh Operation now has a Create New Map check box below the UV Map text field, to allow a new UV map to be created using the name specified.

Select Items in the UV Viewport

You can now select individual UV maps in the UV viewport and in the UV Editor using paint selection and lasso selection while in Items selection mode.

Texel Density Tools

The Texel Density tool has been updated for this release to include the following options:

- **World Space** - Accounts for the item transforms when calculating the 3D sizes. The scaled items can have their texel densities match to unscaled or differently scaled items.
- **Sample Texel Density** - Creates a target density sample from the selected UV Islands.
- **Apply Individually** - Scales each selected UV Island so that its average texel density matches the target.
- **Apply Overall** - Scales all selected UV Islands so that its overall average texel density matches the target.
- **Normalize UVs** - Scales all the selected UV islands, such that their texel density is the same as their total average.

Quick Island Align

To improve your workflow when working with UV Maps, Modo now contains additional UV Align tools. These tools allow you to reposition UV Islands easily.
Island Stacker

To improve your workflow when working with UV Maps, Modo now contains Island Stacker tools.

Foreground/Background Coverage Indicator

To improve your workflow when working on UV maps, we have improved the UV coverage indicator in the UV Viewport. It now displays a percentage value representing the amount of uniform UV space and the geometry in the UV coverage region.

Viewport Improvements

Render Pass Overlay

You can now quickly identify which render pass you are currently working on. The 3D Information Overlays, in the bottom right corner of the 3D Viewport, now displays the name of the selected Pass Groups item and the selected Passes item.

GL Playblast

A new Playblast tool has been added, which allows you to generate a quick preview of your animation. Generating a Playblast output provides you with a realistic idea of your final render results without requiring the time needed for a formal render. You can use this feature to quickly check for character, props, and lighting positioning in your scene.

Group Mask Texture Layers

The 3D Viewport Advanced style has been improved. Modo now supports group mask texture layers for the Advanced viewport style. The display output results look fairly similar to Render Preview output results.

Planar Mapping

You can now set the type of projection mapping for the Front Culling option in the Channels tab. The following options are available:

- **Project Through** - Projects the texture image onto the back face of the mesh, along negative Z direction, and is mirrored to appear the same as the front face image.
- **Cull Backfacing** - Projects the texture image only on the front of the mesh.
• **Flip Backfacing** - Projects and flips a texture image on the back of the mesh along the U and V directions. It appears upside-down.

• **Flip U Backfacing** - Projects the texture image on a back face of the mesh, flipped along U direction, and it is oriented the same way as front face.

• **Flip V Backfacing** - Projects the texture image on a back face of the mesh, flipped along V direction, and it is oriented the same way as front face.

**Item Selection Highlighting**

A new 3D Viewport **Selected Item Drawing** option has been added. You can now select **None** to view selected items in your scene in a fill color and the unselected items in wireframes.

**Bug Fixes**

• Unreported Content: MeshFusion Assemblies are now available through the **Cloud Assets** section of the **Preset Browser** and no longer part of the installed built-in content.

• Unreported File Output: The **Sketchfab** kit was not built-in Modo.

• Unreported Fusion: The Fusion Pie Menu (**Cmd/Ctrl+F**) needs updating. Outdated and/or infrequently used commands have been removed in favor of the five essential Fusion editing commands: **Trim**, **Un-Trim**, **Apply Primary**, **Apply Subtraction**, and **Apply Intersection**.

• Unreported Mesh Fusion: Multi-fusion modes and coincident surfaces caused problems in Modo.

• Unreported Model: The **Tack** tool caused Modo to crash occasionally.

• Unreported Rigging: Unnecessary clamps from the matrix construct modifier were not removed and caused the raw matrices to create an incorrect rotation.

• **BUG ID 25552** - Presets: Applying **Material** presets did not place them in the correct order in the **Shader Tree**.

• **BUG ID 38906** - Painting: Rotating **Text** stuck at 28.6479 degrees.

• **BUG ID 41359** - Schematic: Dragging and dropping **Lights** into **Schematic** viewport from the **Shader Tree** did not work as expected.

• **BUG ID 44773** - UV: Using **Cmd/Ctrl+Shift** with UV move tool didn't work the same for all meshes.

• **BUG ID 46738** - Painting: The **Line** paint tool created a dot in the center of a plane if you drew a line off the edge of the workplane.

• **BUG ID 47600** - UV: The UV patch movement performance was slow. **Crossing UDIM borders** and **Select Overlapped Polygons** options were added to improve the performance.

• **BUG ID 49789** - Schematic: Dragging and dropping **Cameras** into **Schematic** viewport from the **Shader Tree** did not work as expected.

• **BUG ID 50149** - Shader Tree: **Items** were sometimes incorrectly unparented from the **Render** item.

• **BUG ID 52011** - Render: Modo’s default tangent basis handles mirrored UVs incorrectly.
• BUG ID 52038 - Procedurals: Disabling either a **Vertex Bevel** or **Edge Bevel** item in the **Mesh Ops** List caused problems.

• BUG ID 52350 - Procedurals: The **Cube** radius didn't update in a particular scene.

• BUG ID 52585 - Procedurals: Dragging and dropping procedural items from one scene to another didn't work.

• BUG ID 53228 - Model: When moving items across scenes, the items sometimes repositioned.

• BUG ID 54076 - UI: A corrupted **Vertex Map** was created when copying and pasting a Vertex Map onto itself.

• BUG ID 54131 - Shader Tree: Orphaned **Material Tags** were listed in the **Assign Material Tag** dialog.

• BUG ID 54203 - File Output: Exporting selected layers didn't set frame ranges correctly.

• BUG ID 54204 - Paint: The **Image Ink** option frequently failed to switch when changing image.

• BUG ID 54351 - Model: **Edge Bevel** produced inconsistent results.

• BUG ID 54456 - GL: The **GL Count** was incorrect. It did not account for wireframe meshes in independent mode and inactive meshes.

• BUG ID 54491 - Rigging: Placing **Weight Containers** in a Deform folder or removing them was confusing and inconsistent.

• BUG ID 54531 - Content: Built-in **Select by Part** and **Select Polygons by Point Count** selection operator aliases didn't work correctly.

• BUG ID 54648 - Schematic: In a scene with multiple workspaces, the dropdown menu for choosing a workspace showed a tick next to the wrong menu item.

• BUG ID 54668 - Preview: Driving render region channels from other nodes worked in the final render, but not in **Preview**.

• BUG ID 54729 - Render: Colors applied to a **Variation Texture** layer changed when an unrelated item was made invisible or set to not render.

• BUG ID 54957 - Schematic: The Schematic workspace selected wrong workspaces when using the menus selected, copied, and moved.

• BUG ID 54848 - GL: Independent drawing caused incorrect wireframe colors in shaded modes.

• BUG ID 54908 - Render: Displacement of terrains caused dark shadow transparencies.

• BUG ID 55015 - Model: Changing the **Bevel** tool's +/- attributes caused random changes.

• BUG ID 55063 - UI: Pressing **R**, while **Game Navigation**, did not reset the speed to the default value.

• BUG ID 55065 - UI: Pressing **Y**, while **Game Navigation**, did not work.

• BUG ID 55138 - Scripting: Undoing a script using **removeItems** caused Modo to crash.

• BUG ID 55255 - UI: Changing the proficiency levels from **Less** to **More** in the **Bevel Tool** properties caused Modo to crash.

• BUG ID 55262 - Render: **Displacement** combined with **Normal Maps** rendered incorrectly.

• BUG ID 55266 - GL: **Locator** drawing was slower in Modo 11.0 and Modo 11.1.
• BUG ID 55307 - UV: Loading images from the Images tab into the UV window was significantly slower than in Modo 801.

• BUG ID 55331 - Schematic: Selecting a workspace from the dropdown menu did not work as expected.

• BUG ID 55363 - Model: Instances of locator-type items selected instances of transform items, instead of duplicates.

• BUG ID 55368 - Deformers: Altering the bevel on top of a normalized mesh caused Modo to crash.

• BUG ID 55379 - Procedurals: The Merge Vertices option of the Array tool didn't reliably merge vertices, even when they overlapped.

• BUG ID 55410 - Undo: After undoing a polygon selection and then using the procedural tool handles caused unexpected results.

• BUG ID 55439 - File Input: When importing from a triangulated Alembic mesh, Modo meshes with Alembic streaming deformers or Alembic streaming meshes, produced small holes/missing polygons in the mesh.

• BUG ID 55482 - File Input: If two scenes used an image edited in external application, the Image Update Alert went into an endless loop.

• BUG ID 5527 - Shader Tree: Enabling the Change Type option on a Substance Plug-in Material caused Modo to crash.

• BUG ID 55545 - Mesh Fusion: The Intersect Trim operation broke the Fusion Item when opening a scene and updating strips.

• BUG ID 55564 - UV: The UV distortion map and UV vertex map were not accessible. Modo now has a Show UV Distortion and a Select Unmapped Polygons option.

• BUG ID 55575 - UI: When hovering the cursor on a palette, for example the 3D Viewport Properties palette, the cursor flashes until the palette is moved.

• BUG ID 55582 - UV: Using the tear-off modifier Shift+Ctrl keys when moving UVs with the transform tool caused unexpected behavior.

• BUG ID 55582 - UV: The UV Box Transform tool did not support tear-off (on/off) with Shift+Ctrl modifier keys and disallowed mode changes during mouse dragging.

• BUG ID 55597 - Model: The Axis DrillEdge Selection Set option did not work as expected.

• BUG ID 55646 - Preview: Editing the Camera in Preview when one of its channels was locked, did not work as expected.

• BUG ID 55678 - GL: Geometry boundaries drew incorrectly with multiple scenes open.

• BUG ID 55700 - File Output: Replicators exported as Alembic did not export as animated.

• BUG ID 55737 - Procedurals: Changing the Replicator Point Source to a Particle Generator in a specific scene caused Modo to crash.

• BUG ID 55740 - Procedurals: The Bevel Mesh Operation with a falloff and inset didn't function as expected.
• BUG ID 55746 - GL: Drawing a material selection rollover on a procedural mesh when **Enable Deformers** is disabled, caused Modo to crash.

• BUG ID 55771 - Preset Browser: Tooltips showed invalid on **LXO** scenes and **LXT** templates.

• BUG ID 55773 - Model: The UV move **Ctrl+Shift** modifier keys didn't work the same for all meshes.

• BUG ID 55785 - Model: Pen Tool - The **Show Angles** option only worked in the **Perspective, Front, and Back** views.

• BUG ID 55812 - Shader Tree: Moving multiple layers, placed them incorrectly.

• BUG ID 55842 - Model: Enabling the **Tack** tool, **Copy Geometry** and **Make Bridge** options caused Modo to crash.

• BUG ID 55857 - Model: The **Center Selected** option didn't center to the origin when multiple mesh layers were selected.

• BUG ID 55859 - Schematic: Dragging and dropping **Texture Locators** into the **Schematic** viewport from the **Shader Tree** did not work.

• BUG ID 55864 - UI: Setting the **High Res Mesh** option to **(none)** on a Mesh item sometimes caused Modo to crash.

• BUG ID 55867 - Presets: Dragging and dropping a preset material into a **Material Group** did not work as expected.

• BUG ID 55870 - Deformers: Caching deformers in a scene caused Modo to crash due to excessive memory use.

• BUG ID 55882 - Preset Browser: Opening the **3D Viewport's Viewport Textures** menu and pinning it caused Modo to crash.

• BUG ID 55884 - GL: **Viewport Textures** overrides did not save or load correctly with 3D Viewport presets.

• BUG ID 55885 - GL: **Viewport Textures** overrides allowed a **Matcap** image to be deleted and then caused Modo to crash on next **Matcap** load.

• BUG ID 55886 - Model: Using the **Bridge** tool with the guide curve constructed from first vertices caused Modo to crash.

• BUG ID 55887 - Topology: The **Topology Pen** tool didn't remove edges created when using the **Split** mode.

• BUG ID 55891 - UV: The **Show UDIM Number** option did not work as expected.

• BUG ID 55896 - Deformers: Editing the target curve of a **Bezier Effector** did not work as expected.

• BUG ID 55897 - Sculpt: **Specular** and **Shadow** did not display as expected in the 3D Viewport **Default** mode when a displacement layer was added to a mesh.

• BUG ID 55901 - Preview: **Preview** rendered images with the wrong colorspace for non-EXR images.

• BUG ID 55907 - Procedurals: Changing segments in a **Polygon Bevel** mesh operation with a curve connected to a **Path Generator** caused Modo to crash.
• BUG ID 55909 - Modo Bridge: The **Vertex Color Map** did not correctly transfer from the Unreal Engine to Modo.

• BUG ID 55913 - Procedurals: The **Vertex Merge** tool took significantly longer to process in Modo 11 than Modo 10.

• BUG ID 55914 - File Input: **FBX** didn't round-trip vertex colors.

• BUG ID 55925 - Preview: Aborting **render.preview** command left Modo in an unusable state.

• BUG ID 55926 - Preview: Using **modo_cl** with the **render.preview** command caused unexpected results.

• BUG ID 55927 - Preview: Rendering, using the **render.preview** command in **modo_cl**, did not provide a status on the render time left. Executing the following commands: `log.subEnablepreview true, log.toConsole true`, and optionally `log.toConsoleRolling true` enabled an output message.

• BUG ID 55930 - File Input: Opening or importing some **DXF** files caused Modo to crash.

• BUG ID 55934 - Model: Using the Modeling **Select Between** modifier keys with multiple active meshes caused Modo to crash.

• BUG ID 55937 - UI: The **Texture Locator** horizontal wrap slider could not be dragged.

• BUG ID 55939 - Model: Using the **Loop Slice** tool, with specific edges selected in a particular scene, caused Modo to crash.

• BUG ID 55943 - Model: Changing the **Soft Selection Falloff** to respect symmetry state caused bad deformation.

• BUG ID 55946 - GL: After importing **CAD** files, the **Advanced** 3D Viewport displayed red meshes. To address this problem, the maximum number of requested materials and texture instance layers was increased to 32k. In addition, a new OpenGL preference to set the maximum number of requested layers for compatibility and when working on large scenes has been added. Due to OpenGL limitations, this does not address the issue on Mac OS.

• BUG ID 55947 - UV: **UV Distortion** did not display relative UV sizes for all polygons in a mesh layer.

• BUG ID 55948 - Model: The **Loop Slice** tool performed incorrectly when a profile was used.

• BUG ID 55949 - Item List: Dragging and dropping items between specific scenes caused Modo to crash.

• BUG ID 55950 - Shader Tree: Dragging a **Preset** from the Library to the **Shader Tree** did not work in some scenes.

• BUG ID 55969 - Shader Tree: Dragging and dropping an image to the **Environment** didn't work.

• BUG ID 55970 - Presets: Material presets dragged from the **Preset Browser** and dropped between existing **Material Groups** in the **Shader Tree** were placed incorrectly.

• BUG ID 55977 - File Output: Deformation on a prototype mesh for a Replicator didn't export to **Alembic**.

• BUG ID 55979 - Replicators: When you hide a **Replicator** in **ItemsList**, it was visible in the 3D Viewport.
• BUG ID 55984 - UI: Right-clicking in the 3D Viewport, when components were selected, brought up the incorrect context menu.
• BUG ID 55989 - UI: Right-clicking on the Assemblies tab, while in Setup layout, caused Modo to crash.
• BUG ID 56003 - Preview: Rendering a movie file format using Preview viewport with the Render Animation enabled didn't work.
• BUG ID 56015 - Fur: The Variation > Random Twist setting for Replicators didn't work correctly with a Fur material.
• BUG ID 56023 - Procedurals: The Select by Previous Operation with Thicken enabled displayed the incorrect selected name.
• BUG ID 56041 - GL: Switching between two layouts that have RayGL enabled caused Modo to crash.
• BUG ID 56052 - File Output: Replicator hierarchy didn't export to FBX.
• BUG ID 56053 - File Output: Exporting to the Unreal Engine after removing Ptags caused Modo to crash.
• BUG ID 56054 - Model: The Topology Pen tool ignored the morph state.
• BUG ID 56062 - UV: The Box Transform tool did not support symmetry.
• BUG ID 56073 - Shader Tree: The context menu shader selection did not work as expected in some scenes.
• BUG ID 56078 - Shader Tree: Dropping a Material Group in a folder into the Shader Tree failed.
• BUG ID 56083 - Shader Tree: Deleting empty Shader tree folders was not possible.
• BUG ID 56087 - Procedurals: Loading scenes with a Create UVs mesh operation caused Modo to crash.
• BUG ID 56090 - Procedurals: Freezing B-Splines left control vertices.
• BUG ID 56091 - Procedurals: Adjusting a Toroid mesh operation in a particular scene with Replicators caused Modo to crash.
• BUG ID 56094 - Preview (Windows Only): Saving a rendering to a PNG file format from Preview displayed black in Windows Explorer.
• BUG ID 56095 - Particles: The Curve Particle Generator tool generated incorrect particle IDs.
• BUG ID 56103 - UI: Mouse drags on mini-sliders were inadvertently dropped, stopping the slider adjustment.
• BUG ID 56141 - Model: There is no progress bar or the ability to abort when trying to detriangulate high poly meshes.
• BUG ID 56163 - UV: Using the UV Texture Editor on scenes with extremely large UV maps caused Modo to crash.
• BUG ID 56167 - Procedurals: The Slice tool and Axis Slice tool didn't perform correctly with Deformers.
• BUG ID 56197 - Shader Tree: Texture Replicators sometimes appear stretched on some axes.
• BUG ID 56201 - Model: Clearing a polygon selection set in the statistics panel incorrectly deleted the set. The **Clear** menu item was removed from the context menu.

• BUG ID 56221 - Model: The **Mirror** tool **Mirror Generator** > **Axis** option switched back to X when set to Z.

• BUG ID 56230 - Paint: Paint brush preview did not resize when **Auto Scale** was enabled.

• BUG ID 56237 - File Output: The **COLLADA Export Absolute Path** option did not work as expected.

• BUG ID 56260 - Render: Baking an Occlusion layer after making any alterations to the **Vertex Normal Map** caused Modo to crash.

• BUG ID 56290 - Render: Baking diffuse color to a **Vertex Map** didn’t work.

• BUG ID 56294 - Scripting: Using aliases with the `scene.open` command caused Modo to crash.

• BUG ID 56307 - Fusion: MeshFusion failed randomly when drilling small holes.

• BUG ID 56312 - Model: **Vertex Map** > **Apply Map** broke opened edges.

• BUG ID 56371 - UV: Using the **Mirror UVs** tool with UV Symmetrize activated did not find the position of the **Center** of the mirroring operation.

• BUG ID 56397 - Render: When rendering a scene file with all render outputs disabled, the error message did not provide useful details.

• BUG ID 56407 - Shader Tree: Items under the **Shader TreeLights** folder couldn’t be re-ordered.

• BUG ID 56418 - Fusion: MeshFusion multi-piece trim produced unexpected results.

• BUG ID 56447 - Audio: Loading a missing audio clip and then displaying the waveform caused Modo to crash.

• BUG ID 56449 and 56450 - Fusion: Trim meshes, consisting of two disconnected pieces, were incorrectly displayed in the output mesh.

• BUG ID 56459 - Procedurals: **Deformers** failed to work when mesh operations above them were disabled.

• BUG ID 56478 - Render Window: The Render window did not remember if you changed the configuration of the pane size.

• BUG ID 56501 - Render: Using the **Vertex Shader Baking** function, with the **Bake Type** set to **Selected Render Output**, resulted in a black bake.

• BUG ID 56506 - UI: The **Unreal Bridge** icon took up too much room in the interface. A better tooltip was added.

• BUG ID 56525 - UV: The **UV Box Transform** tool does not scale from top-right corner occasionally.

• BUG ID 56533 - Model: When the scene didn’t not have a mesh layer, the **Arc** and **Solid Sketch** tools could still be used.

• BUG ID 56558 - Preview: Editing the **Shader Tree** with some Mesh Light setups caused Modo to crash.

• BUG ID 56617 - GL: Editing geometry in a quad model view with the perspective view set to Advanced caused Modo to crash.
• BUG ID 56667 - Fusion: Fusion failed due to a bad input mesh (such as a twisting self-intersecting mesh) and sometimes caused Modo to crash.

• BUG ID 56669 - Shader Tree: The Auto Create Item Masks Preference incorrectly added the masks above the Base Shader.

• BUG ID 56677 - GL: Windows 10/NVidia GTX: Very poor performance in some cases. The bug is fixed by adding an NVidia driver profile which disables Threaded Optimization on Windows.

• BUG ID 56689 - Mesh Types: Setting a Proxy's preview mesh to a static mesh in the Proxy caused Modo to crash.

• BUG ID 56690 - Model: Resetting the Curve tool with a curve active caused Modo to crash.

• BUG ID 56695 - Fusion: Successive application of the Extend Edge tool on a MeshFusion source mesh caused Modo to crash.

• BUG ID 56708 - Procedurals: Polygon Bevel random selection seed value changed with animation frames.

• BUG ID 56709 - Fusion: Fusion strips flared out when present on a Catmull-Clark subdivision surface and the Boundary Rule was not set to Smooth All. This caused the strips to terminate on corner quads.

• BUG ID 56714 - UV: The Orient Pieces command using the Vertically option did nothing.

• BUG ID 56723 - Model: Sketchfab's Auto Freeze function did not freeze the displacement into the mesh.

• BUG ID 56724 - Headless: Launching modo_cl command caused random crashes in Modo.

• BUG ID 56725 - GL: Drawing nested replicators with the 3D Viewport option Drawing and ControlReplicator set to All caused Modo to crash.

• BUG ID 56753 - Scripting: A script execution from a PySide custom view, when used consecutively on multiple scenes, caused Modo to crash.

• BUG ID 56767 - Sculpt: Reducing Catmull Clark Subdivision Level removed any multiresolution sculpting already performed on the mesh.

• BUG ID 56811 - Replicators: Nested replicators did not draw correctly in the 3D Viewport.

• BUG ID 56818 - Replicators: Setting two replicators to use each other as prototypes caused Modo to crash.

• BUG ID 56872 - UV: It was impossible to turn off Select Through option for UV Box Transform tool.

• BUG ID 56879 - UV: In the UVEdit layout, using the Rotate tool did not work or display any tool properties in the Mesh Ops List.

• BUG ID 56892 - Preview: Preview: Crash Preview rendering a specific scene at Final Render Quality with Preview Auto Save enabled.

• BUG ID 56958 - UI: Mac: Empty edit fields are not reverted to their default names/values when committed.
Known Issues and Workarounds Specific to Modo 11.2

This section covers known issues and gives workarounds for them, where appropriate.

Advanced Viewport

- BUG ID 56706 - Unity and Unreal materials are not displayed correctly when first loaded.
  
  As a workaround: Enable and then disable the visibility of the Shader Tree textures.
- BUG ID 55594 - Wireframe is missing from orthographic views.
  
  As a workaround: Change Line Antialiasing from Full to either Off or System.
- BUG ID 50810 - Anisotropic texture filtering is lower quality than in the Default viewport.
- BUG ID 46995 - Ambient Occlusion display in the Advanced viewport is affected by selected item wireframes.
  
  You can disable Show Selection in the Visibility options or disable wireframe drawing on the active mesh layers.

Animation

- BUG ID 53661 - Selecting actions does not always select the correct one. This is caused by copying actions.
  
  As a workaround, manually edit the tags on the broken actions by selecting them in the Groups tab, then save and reload the scene.

Assemblies

- BUG ID 36452 - Assemblies exported from the Item List context menu result in poor visual layout of nodes on import.
  
  As a workaround, you can save assemblies from the Schematic viewport.

Baking

- BUG ID 50671 - Baking displacement maps can cause UV seams to be visible, and the baked displacement map to show quilting effects and other render artifacts.
- BUG ID 49437 - The Bake Channel Swizzling option can't bake to texture alpha.
Color Management

- BUG ID 49244 - (Windows only): With **Perform Color Correction** on, setting a default scene to a scene with a mesh that has a position channel crashes Modo at launch.

  As a workaround, use **System > Reset Preferences** to reset to defaults or move/remove the default scene.

Default Viewport

- RGBA textures only draw correctly in the **Advanced** viewport. In the **Default** viewport, any unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in the **Shader Tree**.

Deformers

- BUG ID 56726 - Deformed Instances that are off-screen are incorrectly drawn at the origin.
- BUG ID 55470 - Freezing a mesh with normalized deformers and a Mesh Op caused Modo to crash.

File and Image I/O

- BUG ID 56862 - Modo for SolidWorks Kit: Modo crashes when importing the same **SolidWorks** file twice in one Modo session. This bug only affects import using the kit, not direct imports (**File > Import**).

  As a workaround: Before importing a **SolidWorks** file for the second time, exit and restart Modo.
- BUG ID 55439 - Alembic imported convex polygons with at least two close to co-linear edges may not draw correctly in GL (appearing as missing triangles).

  As a workaround: Import using the new Alembic Streaming options. Set the **Polymesh streaming options** to **Alembic Streaming Meshes (polys only, force all)**. Alternatively, select the base material in the **Shader Tree** and enable **Surface Normal > Double-sided**, then change the **Smoothing** angle to **180**.
- BUG ID 50198 - Alembic scenes don’t export some surface items, including static meshes and procedural shatter items.
- BUG ID 49728 - Exporting selected layers (from the **Item List** context menu) to **.fbx** doesn’t export instances, unless the original mesh is also exported.

  To resolve this, set the **.fbx** preference to **Export Selection** and use **Export As**....
• BUG ID 47036 - Color management in .svg images is not currently supported. This is a side-effect of a bug fix where the largest allowable image size (64k x 64k) was always used when color correction was enabled.
• BUG ID 46962 - Rendering .svg images used as stencil maps for displacement or for layer masking can be very slow.

Fur
• BUG ID 35731 - Fur length textures can't be edited with the Stretch tool.
  Use different fur length drivers, such as hair guides or vector vertex maps.

General
• BUG ID 49514 - Mac OS X only: Running modo_cl before running the UI Modo application breaks code signing.
  As a workaround, start the UI version of Modo once, before running modo_cl on any system where you later intend to use the UI version.

GL
• BUG ID 55816 - Wireframes are washed out on transparent surfaces in the Advanced viewport.
  As a workaround, avoid transparency when modeling or doing work where wireframes are needed. Alternatively, use the Default viewport.
• BUG ID 55746 - Moving the mouse over a procedural mesh, when Animation > Enable Deformers is off, may cause Modo to crash.
• BUG ID 55594 - Wireframe overlay is missing in orthographic views if Line Antialiasing is set to Full in the Advanced viewport.
  As a workaround, use the Line Antialiasing > System or Off option instead.
• BUG ID 55500 - Setting the Advanced viewport Effects > Material option to Basic displays Unreal materials as white.
  As a workaround, use Simple mode.
• BUG ID 55145 - Default viewport lights are not casting shadows in the Advanced Viewport.
• BUG ID 54456 - GL count is incorrect in certain circumstances, including when meshes are displayed in wireframe mode or when displaying replicas.
• Windows only: Using Raptr can cause GL driver crashes in Modo.
Input Devices

• BUG ID 51741 - Mac OS X only: Modo sometimes becomes unresponsive when using the combination of a click-drag in a tree view (for example, when toggling the visibility of two successive items in the Shader Tree), followed immediately by a two-finger scroll gesture on some devices, including laptop trackpads and the Magic Mouse.

As a workaround, change to a 3-button mouse (recommended to fully access all of Modo’s features).

• BUG ID 35856 - Linux only: Plugging in a Wacom tablet while Modo is running can cause undesired movement. This cannot be fixed, due to a limitation of the hardware driver.

To avoid this, plug in the tablet before application startup or restart.

Item List

• BUG ID 53209 - Group creation (Ctrl + G) places the new group folder at a random position in the Item List, if the items are not selected in a top down sequence.

As a workaround, select the items being grouped from top to bottom in the Item List before grouping (Ctrl + G).

Mesh Fusion

• BUG ID Bug 56973 - If a Trim Fusion role is assigned to an object and then it is dragged and dropped onto a Primary, the drop menu does not contain the Trim boolean options.

As a workaround, use either the Fusion Buttons (Tool palette - Set Mesh Role & Apply section) or Pie Menu (Apply SubtractionApply Intersection or ) when initially adding Trims to each Fusion Item (Trims can contribute to multiple Fusion Items). If initially applied with either of those methods, all subsequent Drag & Drop options will be supported.

Modeling

• BUG ID Bug 55857 - Using the Model layout Toolbox Basic subtab Center Selected option on a polygon selection, with multiple mesh layers selected, doesn’t center to the origin.

As a workaround, select only one mesh layer at a time or put all geometry in one layer.

• BUG ID 55842 - Using the Tack tool, with Align, Copy Geometry, and Make Bridge options enabled may cause Modo to crash.

• BUG ID 32728 - Zooming out with a Space Navigator alters the Work Plane position.
Network Rendering

• BUG ID 48325 - Scenes with image sequences rendered with Full Frames use the wrong image sequence number on slave machines.

As a workaround, use File > Consolidate Scene, then render the scene using a shared network folder (Preferences option under Rendering > Network Rendering).

• BUG ID 36986 - Slaves render hidden meshes. Since mesh hide state is not stored in the scene, when that scene is transferred to the slaves, the state is lost. The master respects the hidden state, however.

As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or open System > Preferences > Rendering and disable Use Network Render Nodes.

• BUG ID 30318 - Network Rendering doesn't support Realflow particles.

• BUG ID 25636 - Frame passes are not supported.

• Several Bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not implemented to support baking. Changes to Modo in the 10-series apparently broke what was working for some artists, so the functionality has been disabled.

As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an external render controller. For more information, please see the SDK Wiki.

Node Shading

• BUG ID 50642 - Nodal shading does not support UDIMs.

Painting/Sculpting

• BUG ID 41682 - Textures are not always updating in Preview/Render when painting on an image map.

You can save and reload the image to force the update.

Particles

• BUG ID 44551 - Surface Particle Generators may not update with changes to a Density Gradient Input set to Slope.

As a workaround, choose Distance to Locator or any other setting from the Density Gradient Input dropdown, then change it back to Slope.
• BUG ID 34925 - Re-opening scenes saved with large particle caches can cause problems.

To avoid such issues, delete the cache before closing Modo, or export the particles to .csv cache files or Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation item in the Schematic viewport, and clicking Cache Simulation.

Preset Browser

• BUG ID 55882 - Pinning the Viewport Textures preset browser crashes Modo on restart.

As a workaround, run Modo in Safe Mode and select System > Reset Preferences or manually delete the main config file.

Presets

• BUG ID Bug 55867 - Dragging and dropping a preset material into a material group places the preset above the Base Material, not in the group.

As a workaround, move the preset material group after dragging and dropping it.

Preview

• BUG ID 55901 - Preview is rendering images with the wrong color space for non EXR images.
• BUG ID 55646 - The Camera can’t be edited in Preview if any of its channels are locked.
• If a high poly mesh is not visible, the Preview baking output will be incorrect.

As a workaround, reset Preview to fix the baking.

Procedurals

• BUG ID 56908 - Merge Meshes can corrupt UVs created in Mesh Ops.
• BUG ID 56318 - Procedural duplication of Mesh Ops in a Deform folder creates errant Mesh Ops list.
• BUG ID 56317- Duplication of Procedurals does not work with the Select By Previous Operation tool.

As a workaround, manually edit the duplicate’s Select By Previous Operation Mesh Ops.
• BUG ID 54738 - A duplication of any item that is a Merge Meshes Source (For example, a Mesh Item, Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to the Merge Meshes Ops List as a source.
As a workaround, remove the unwanted additional Merge Mesh Sources (regardless of the type of source) in the Mesh Ops List using the X icon in that list next to each Merge Meshes source.

- BUG ID 52149 - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal option doesn't work when using a Bezier with zero-length tangents.

As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there are no zero-length tangents.

- BUG ID 49767 - Scenes, which contain a UV constraint modifier driving texture properties, may fail to load after saving, due to a modifier dependency loop.

- BUG ID 46512 - When rigged, Rock items and other procedurals do not display correctly in GL. This is a limitation of the feature and will not be fixed.

You can use Preview or RayGL to visualize the variations from rigging.

Projections

- BUG ID 49473 - Projections are incorrect if the projecting camera is set to Vertical film fit mode and the width is less than the height.

- BUG ID 43771 - Camera projections from non-render cameras show distortion in GL and baking.

To avoid this, make sure that the projection camera has a film width-to-height ratio that matches the main render camera.

References

- BUG ID 44492 - If a scene that already contains references is referenced, the shading of the original references may not persist.

As a workaround, limit scenes with shading to one level of reference.

- BUG ID 41119 - Reloading a reference after replacing it with the same file can cause Modo to crash.

Rendering

- BUG ID 56874 - Polygon artifacts when using a bump texture, are more pronounced when using the new Per-Ray Fresnel feature in Modo 11.2v1.

As a workaround: The effect can be reduced by increasing the size of the bump texture, reducing the bump amplitude, or enabling AA on the bump texture.

- BUG ID 56620 - Modo crashes when closing a scene containing a referenced scene after attempting to revert a reference override.
As a workaround: First close and reopen the scene before attempting to revert the reference.

- BUG ID 56585 - The **Render Current View** command, with **Preview** running, may cause an error.

As a workaround: Pause **Preview** before rendering.

- BUG ID Bug 55787 - The **Scratches** procedural texture may produce NaNs in the **Preview viewport** and **Render Display**.

- BUG ID Bug 55663 - **Motion Blur** applied on a curve in a Mesh Operation no longer works.

- BUG ID Bug 55262 - Displacement combined with normal maps renders incorrectly.

As a workaround, enable the **Displacement as Bump** option in the **Render Item Settings** or render using **Preview**.

- BUG ID 53411 - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels) in some cases.

As a workaround, use a **Maximum Radiance** higher than 1 W/srm² to reduce the bias.

- BUG ID 53184 - Value presets created for material Subsurface Scattering samples in Modo 10.1 or earlier now show on the render item instead.

- BUG ID 52730 - The Vertex Illumination Bake command doesn't work as expected, when the mesh has transform channels.

As a workaround, freeze the transforms in the mesh properties.

- BUG ID 52011 - Tangent Basis handles Mirror UVs incorrectly.

As a workaround, apply Mikk or any other tangent space basis to the mesh before baking.

### Rigging

- BUG ID 55059 - Binding can't be used multiple times in **Setup** mode.

As a workaround, exit and re-enter **Setup** mode.

- BUG ID 27244 - Duplicating joints in a bound mesh retains influences from the original joint chain.

### Schematic

- BUG ID 55859 - Dragging and dropping a **Texture Locator**, **Camera**, or **Light** from the **Shader Tree** into **Schematic** viewport doesn't work.

As a workaround, with the item selected, click the **Add Selected** button in the **Schematic** viewport.
Scripting

- BUG ID 53458 - Right-clicking or running a script in the Script Editor can lock up input to Modo.
  
  As a workaround, click in the top window of the Script Editor, use the main menus, or change to another application, then switch back to Modo.
- BUG ID 55138 - Modo crashes when undoing a script which uses `removeItems`.

Sculpt

- BUG ID 55897 - Specular and shadows in the `Default` viewport stops showing when sculpting on a displacement image.
  
  As a workaround, use another viewport mode such as Advanced or Reflection, or apply a Matcap shader to the Shader Tree.

Shader Tree

- BUG ID 37858 - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip browser) fails.
  
  To work around this issue, in the Clip Browser, choose a single image instead of the group, and then change to the image group using the Texture Layer's Properties tab.
- BUG ID 30947 - Layer masking displacement does not work unless you drag and drop the masking layer onto the displacement layer.

Topology

- BUG ID 55887 - In Remove mode, the Topology Pen doesn't remove edges created by the Split mode but instead removes the underlying polygon.

Unreal and Unity Materials

- BUG ID 50701 - Unreal material Ambient Occlusion does not bake correctly in Modo.
- BUG ID 50700 - There is no way to visualize the Unreal SubSurface Color effect in Modo.
- BUG ID 50451 - On some graphics cards, Unity material may cause flickering in the Advanced viewport when used with bump maps and shadows.
UI

• BUG ID 55759 - Transforming objects can cause the Items Properties panel to flicker.
• BUG ID 55702 - Mac OS X only: Saving layouts on certain multi-display configurations caused Modo to crash.

As a workaround, having your primary display as the left-most, may prevent this.
• BUG ID 55571 - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.
• BUG ID 55185 - Text in the viewport icon buttons is not visible in the Advanced viewport on some Mac OS/AMD configurations.

As a workaround: Upgrade Mac OS to 10.12 or 10.13.
• BUG ID 44496 - Mac OS X only: Disabling Affect System Color Dialog in Preferences > Rendering > Color Management, and using the system color picker caused colors to darken with each use of the color picker.

This is due to an OS X issue, which requires the color profile in both the monitor settings and color picker to be set to sRGB IEC61966-2.1.
• BUG ID 44896 - Dragging and dropping an image from disk into the Clips list doesn't work.

If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below other images in the list.
• BUG ID 43162 (Windows only) - Setting a custom text size affects Modo's text drawing.

As a workaround, go to the compatibility settings by right-clicking the Modo shortcut or executable, and turn off font-scaling for the application.

UV

• BUG ID 56967 - If UV distortion is enabled in both the UV and 3D viewport, editing the mesh in the 3D view causes the UVs to turn black.

As a workaround: Toggle the UV texture visibility or avoid enabling Show Distortion on in both views.
• BUG ID 55891 - Show UDIM does not display the UDIM number in the UV viewport.

As a workaround, enable the Auto Spans option.
• BUG ID 55582 - The Tear-off modifier keys (Shift+ Ctrl) are live in the UV Transform tool, meaning the Tear-off state changes during the drag if the keys aren't held down.
• BUG ID 55564 - The UV Distortion and UV Vertex maps are no longer accessible. This is due to bugs and crashes with these ‘internal’ maps being visible to users. Modo 11.2 will introduce features to replace prior uses of these maps.

Developer Notes

• BUG ID 53988 - SDK: The `item.channel` query didn't read evaluated strings correctly.
• BUG ID 55473 - SDK: A reference scene loaded twice did not return geometry in `CLxSurfaceVisitor.Sample()`.
• BUG ID 55749 - SDK: Viewing graph for a plugin's alpha channel, if no keys were set, caused Modo to crash.
• BUG ID 56467 - SDK: Reading an item graphs in a command's enable function sometimes caused Modo to crash if the scene changed.
• BUG ID 56697 - SDK: `Rendercache` crashed Modo when closing the scene.